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Introduction
FlashPro Express is Microchip’s programming software tool designed from the ground up to address secured
programming assurance in production programming house environments. FlashPro Express software supports
PolarFire®, PolarFire SoC, SmartFusion®2, IGLOO®2, and RTG4™ in Windows and Linux OS environments, using
the FlashPro Programmer hardware.

You can install FlashPro Express two ways:

• Integrated with Libero- FlashPro Express installs automatically when Libero® is installed. FlashPro Express
is used by Libero to perform the programming tasks for PolarFire, PolarFire SoC, SmartFusion2, IGLOO2, and
RTG4, as part of the design flow.

• Stand-alone- FlashPro Express is also available as a stand-alone installation. This installation method is
primarily used for production programming or lab programming on machines that do not require a full version of
Libero.

For more information about FlashPro Express, see the Microchip website.
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1. Overview
This section provides an overview of FlashPro Express.

1.1 FlashPro Hardware Programmers
The FlashPro series of hardware programmers consists of:

• FlashPro3/X
• FlashPro4
• FlashPro5
• FlashPro6

All FlashPro series hardware programmers save board space because a single JTAG chain can be used for all
JTAG devices. In-system programming using the JTAG port adds the flexibility of field upgrades or post-assembly
production-line characterization. Production costs are reduced significantly as a result of elimination of expensive
sockets on the board.

Note:  FlashPro5 and FlashPro6 support programming though a device SPI Slave port.

For more information, visit the Microchip website.

1.2 Secure Job Programming
Job programming is the concept of using a single file to program a Microchip device or chain of Microchip devices
using encrypted bitstreams.

The single job file contains all of the information necessary to setup FlashPro Express as well as the encrypted
bitstream images for the devices in the job. After a job file is created, it can be passed securely to production
programming houses or contract engineering facilities to load the Microchip images during manufacturing. Job
projects can be exported from Libero and imported into stand-alone FlashPro Express, providing a clean delineation
between design flow and production programming.

1.3 Migrating FlashPro Projects to FlashPro Express
Existing FlashPro projects (*.pro) files are called Job Project files in FlashPro Express. These Job Projects can be
opened with FlashPro Express to take advantage of Linux programming support and the simplified tool targeted for
operators in a production floor environment.

Note:  FlashPro projects that were created in single mode are not supported by this tool. Microchip recommends that
you convert these projects to chain mode projects.

To convert the project to a chain project:

1. Open the FlashPro project (*.pro) in FlashPro.
2. Locate the loaded STAPL file by one of two methods:

The log prints STAPL file ‘<stapl_path>’ has been loaded successfully. <stapl_path> is the location of the
STAPL file loaded.

Figure 1-1. Sample Log Message

In the Single Device Configuration window, the field STAPL_FILE_NAME shows the location of the STAPL file
loaded.

 Libero® SoC v2021.2
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Figure 1-2. Location of STAPL File

1. Switch the project to chain mode using one of the two methods:

– Press the chain button from the toolbar: 
– From the Tools menu, select Mode > Chain Programming.

2. Load the STAPL file in chain mode by adding a Microchip device in the chain.
2.1. From the File menu, select Configuration > Add Microchip Devices from Files.
2.2. Browse to the location of the STAPL file and click Open.

3. To save the project, from the File menu, select Save Project.

You can now open the project using FlashPro Express.

When moving FlashPro project (*.pro) files to another machine, Microchip recommends that you archive the entire
project folder, copy it to the new machine, extract it locally, and then load the job project within FlashPro Express.
FlashPro Express opens a job project only when a programmer is connected to the machine, at least one Microchip
device has programmed enabled, and all enabled Microchip devices have a bitstream file loaded.

 Libero® SoC v2021.2
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2. Installing FlashPro Express Software and Hardware
For information about installing the FlashPro Express hardware and software, see the Microchip website.
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3. Supported Device Families
The following table lists the device families and their derivatives that FlashPro Express can program directly through
Libero or by exporting a FlashPro Express job.

Table 3-1. Product Families and Derivatives Directly Supported by FlashPro Express

Device Family Description

PolarFire Lowest power, cost optimized mid-range solution.

PolarFire SoC Lowest power, multi-core RISC-V SoC FPGA.

SmartFusion2 Addresses fundamental requirements for advanced security, high reliability, and low power in
critical industrial, military, aviation, communications, and medical applications.

IGLOO2 Low-power mixed-signal programmable solution.

RTG4 Radiation-tolerant programmable solution.

 Libero® SoC v2021.2
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4. Getting Started
This section describes how to get started using FlashPro Express.

4.1 Starting FlashPro Express
FlashPro Express software is made available in the <Libero SoC installation folder>\bin folder. Execute
the FPExpress file to launch the FlashPro Express software.

4.2 FlashPro Express Interface
The main FlashPro Express UI consists of a list of programmers and a chain table. This view displays the
programmers connected to the machine, and the devices within the JTAG chain (Figure 4-1) or a single device
with SPI Slave interface (Figure 4-2) specified in the job project file (PRO) file.

Figure 4-1. FlashPro Express Programmers and Chain Table (JTAG Example)

 Libero® SoC v2021.2
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Figure 4-2. FlashPro Express Programmers and Chain Table (SPI Slave Example)

The following table describes the FlashPro actions you can perform. Devices specified as disabled in the job project
(*.pro) file are shown disabled and their HighZ value appears in the column header.

Table 4-1. FlashPro Actions

To... Perform This Action...

Display more information about a programmer. Hover over the programmer Info icon.

Change a programmer name. Click the Name field.

Enable or disable a programmer. Click the check box.

Ping, Self-Test, Scan, Check Chain, or Remove it from
the list.

Right-click a programmer.

View additional information about a device and
programming file, if loaded.

Hover over the info icon of that device.

The following table describes the device/programmer states.

Table 4-2. Device/Programmer States

Device/Programmer State Description

IDLE Devices and programmers are idle and not executing
any programming action.

DISABLED Devices that are not enabled for programming.

PASSED Last programming operation passed.

FAILED Last programming operation failed.

Note:  SPI Slave mode is supported by FlashPro5 for SmartFusion2 and IGLOO2 devices, and by FlashPro6 for
SmartFusion2, IGLOO2, and PolarFire devices. JTAG is the default interface. RTG4 devices do not support SPI
Slave programming.
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4.3 Creating a Job Project from a FlashPro Express Job
When you are ready to hand off your design for production, create a job project.

1. In Libero, run Export FlashPro Express Job to create a container that will be used to transfer programming
configuration information, including programming files, to the production programming tool FlashPro Express.
Figure 4-3. Export FlashPro Express Job

2. In FlashPro Express, from the Project menu, choose New Job Project.
3. When prompted, specify the Programming Job file location that you just exported from Libero and the location

to store the FlashPro Express job project. The job project name uses the programming job name and cannot
be changed. Click OK to create and open a new job project for production programming.

Figure 4-4. New Job Project from FlashPro Express Job Dialog Box

 Libero® SoC v2021.2
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Figure 4-5. New Project from FlashPro Express Job Dialog Box in Developer Mode

In Developer mode, a new job project can also be created using Construct automatically option. This option can
be used to construct chain by scanning the physical chain connected to the selected programmer. This feature is
available only in JTAG mode. If multiple programmers are connected to the machine, select the desired programmer
by clicking on the pull down menu for connected programmers field.

4.4 Opening a Job Project
To start with FlashPro Express, load a job project (*.pro) file.

 Libero® SoC v2021.2
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A job project opens if:

• At least one programmer is connected.
• At least one Microchip device is enabled for programming (Required for Operator Mode).
• Any enabled Microchip device for programming has a bitstream file loaded.

To open a job project:

1. From the Project menu, choose Open Job Project. The Open Project dialog box appears.
2. Find your project file or type in your project file name in the File name field.
3. Click Open.

Figure 4-6. FlashPro Express Launch Screen

4.5 Saving a Job Project
To save a job project, either:

• Click the Save button on the toolbar, or
• From the Project menu choose Save Job Project.

4.6 Programming Tutorials
The following programming tutorials describe real-world examples of using FlashPro.

 Libero® SoC v2021.2
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4.6.1 Parallel Programming with FlashPro5/4/3/3X
Parallel programming allows you to program multiple Microchip devices in parallel with multiple programmers. In
parallel programming, all targeted devices are programmed with the same programming file (STAPL). The targeted
device or chain configuration that is connected to each programmer must be identical.

The FlashPro Express software together with the FlashPro5/4/3/3X programmers supports parallel programming via
a USB port. You can connect up to sixteen FlashPro5/4/3/3X's to a PC via a USB v1.1 or a USB v2.0 port.

FlashPro5/4/3/3X requires a self-powered hub.

Connecting FlashPro5/4/3/3X (a USB v2.0 enabled programmer) to USB v1.1 port increases device programming
time due to a slow data transfer rate on the USB v1.1 port in comparison to a USB v2.0 port.

The following figure shows how to connect a FlashPro5/4/3/3X programmer for parallel programming.

Figure 4-7. Connecting a FlashPro5/4/3/3X Programmer

An independent thread processes the STAPL file during parallel programming. In a Microchip test environment,
parallel programming is approximately five times faster than programming 16 devices sequentially.

Note:  Microchip has tested Belkin PCI-USB cards and hubs, and found that parallel programming works best when
using the vendor's latest driver installed along with matching hubs.

4.6.2 Chain Programming Tutorial
This tutorial describes how to use FlashPro Express to program a multi-device, multi-programmer chain. This
tutorial uses the production programming flow that exports a programming job from Libero SoC, which includes
chain configuration, programmer settings, and bitstream files for programming, and creates a job project from a
programming job.

The following figure shows the chain used in this tutorial. M2S050T is device 1 and A3P250 is device 3.
• Device 1 is the first device to be programmed in the chain.
• Device 2 is the last device to be programmed in the chain.
• Device 3 is disabled and will not be programmed.

 Libero® SoC v2021.2
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Figure 4-8. Chain Programming Devices

To program a chain:

1. From the Project menu, choose New Job Project from FlashPro Express Job.
2. Click Browse to load a Programming Job File, and specify your FlashPro Express job project location.

Click OK to continue, as shown in the following figure.
Figure 4-9. New Job Project from FlashPro Express Job

FlashPro Express displays your Job Project and programmers, as shown in the following figure. The Device/
Programmer states are:

– IDLE: Devices/programmers are idle and not executing any programming action.
– DISABLED: Devices that are not enabled for programming.
– PASSED: Last programming operation passed.
– FAILED: Last programming operation failed.

 Libero® SoC v2021.2
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Figure 4-10. FlashPro Express with Loaded Job Project (JTAG Example)

Figure 4-11. FlashPro Express with Loaded Job Project (SPI Slave Example – SmartFusion2/IGLOO2
Only)
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3. If your programmer is not listed, click the Refresh/Rescan button. To view device info, hover your mouse over
the Info icon. If a device is Disabled for programming, the HighZ status appears in the GUI.

4. Set the Programming Action in the drop-down menu to PROGRAM, as shown in the following figure.
Figure 4-12. Programming Action Set to PROGRAM

5. Click RUN. Detailed individual programmer and device status information appears in the Programmer List.
Your programmer status (PASSED or FAILED) appears in the Programmer Status Bar, as shown in the
following figure.

– Hover over the Programmer Status Bar to display information on the programmers.
– Hover over the FAILED status to list all programmers that failed programming.
– Hover over the PASSED status to list all the programmers that programmed successfully.

Figure 4-13. Chain Programming Complete

6. View the Log for Messages, Errors, Warnings and Info generated during programming.

 Libero® SoC v2021.2
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5. Programming Connectivity and Interface
The Programming Connectivity and Interface option can be selected from the Tools menu.
Figure 5-1. Programming Connectivity and Interface Option in Tools Menu

By default, the tool selects the first enabled programmer and opens the Programming Connectivity and Interface
dialog box with an existing JTAG chain or SPI Slave device. If there is no programmer enabled, an error message is
shown. The user can disable all programmers, except the one which is used by the FlashPro Express tool.

The selected programmer and current programming interface are shown in the dialog box for the user reference. The
main window’s programmer table is cleared as soon as the chain dialog box is opened and will be populated with
saved changes or restored to previous state if changes are canceled when the dialog box is closed.
Figure 5-2. Programming Connectivity and Interface Dialog Box with Configure Chain Options

For JTAG Interface, the same configure chain options are available as in Libero SoC tool.

For SPI Slave interface, the following options are available:
• Set Programming Interface: Selects JTAG or SPI Slave mode.
• Add Microsemi Device: Adds a Microsemi device to the chain.
• Delete device: Deletes selected devices in the grid.
• Zoom In: Zoom into the grid.
• Zoom Out: Zoom out of the grid.

The devices used in FlashPro Express tool have the following context menu options:

 Libero® SoC v2021.2
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• Configure Device: Configure device is same as the one in Libero SoC tool. Configure device option allows to
configure device by loading programming file (but not a SPI Flash file) or to set device family and die.

• Enable/Disable Device for Programming: Enables or disables device for programming.
• Load Programming File: Loads the programming file.
• Unload Programming File: This option is enabled if programming file loaded.
• Load SPI Flash File: Loads a SPI Flash file. This option is always enabled. It is available for PolarFire and

PolarFire SoC devices.
• Unload SPI Flash File: This option is enabled if SPI Flash file is loaded. It is available for PolarFire and

PolarFire SoC devices.
• Set Serial Data: This option is disabled; serialization is not supported.
• Move Device: to left/right

There is no option to configure/select programming action or SPI Flash action. This option is only available in the
main table because it depends on the developer mode option to run one programming action for all devices or run an
action selected for each device.

From Libero SoC v12.6 onwards, you can change a device type by loading the programming file for a different device
type. This is consistent with Libero flow.

In the chain dialog box and in the main table, the user can load the programming file for a different device type with a
GUI confirmation. The chain tool also allows the user to re-configure the device by selecting a different family and a
die. In this case, no confirmation is required.

In the batch mode, a programming file is loaded with a warning.

 Libero® SoC v2021.2
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6. Programmer Settings and Operations
This section describes the FlashPro Express settings and operation.

6.1 Introduction
The FlashPro Express software allows you to connect multiple programmers to your computer. With each
programmer you select, you can perform a ping, conduct a self-test, scan and check the chain, and remove, enable,
or disable the JTAG chain, as shown in the following figure.
Figure 6-1. FlashPro Express Right-Click Menu

6.2 Programmer Settings
To view the Programmer Settings dialog box, in the Libero SoC Design Flow window, expand Configure Hardware,
double-click Configure Programmer or right-click Configure Programmer and choose Programmer Settings.

For the JTAG interface, you can set specific voltage and force TCK frequency values for your programmer in this
dialog box. For the SPI Slave interface, you can force SCK frequency values for your programmer. SPI Slave mode is
supported by FlashPro5 for SmartFusion2 and IGLOO2 devices, and by FlashPro6 for SmartFusion2, IGLOO2, and
PolarFire devices. SPI Slave mode is not supported for RTG4 devices. JTAG is the default interface.

 Libero® SoC v2021.2
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Figure 6-2. Programmer Settings

The Programmer Settings dialog box includes options for FlashPro6/5/4/3/3X. Limitations of the TCK frequency for
the selected programmer are:

• FlashPro6: 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20 MHz
• FlashPro5: 1, 2, 3, 4, 5, 6, 10, 15, 30 MHz
• FlashPro4: 1, 2, 3, 4, 5, 6 MHz
• FlashPro3/3X: 1, 2, 3, 4, 6 MHz TCK frequency limits by target device (refer to the target device data sheet)

During execution, the frequency set by the FREQUENCY statement in the PDB/STAPL file overrides the TCK
frequency settings you select in the Programmer Settings dialog box, unless you also select the Force TCK
Frequency check box.

Limitation of the SCK frequency for the selected programmer are: 1.00, 2.00, 2.50, 3.33, 4.00, 5.00, 6.67, 8.00,
10.00, 13.33, and 20.00 MHz

6.2.1 FlashPro5/4/3/3X Programmer Settings
For FlashPro5/4/3/3X, if you choose the Force TCK Frequency, select the appropriate MHz frequency. For
FlashPro4/3X settings, you can switch the TCK mode between a Free running clock and a Discrete clocking. Use
discrete clocking when there is a JTAG non-compliant device in a chain with Microchip devices. After you make your
selections(s), click OK.

6.2.1.1 Default Settings
• The Force TCK Frequency option is unchecked to instruct the FlashPro5/4/3/3X to use the TCK frequency

specified by the Frequency statement in the PDB/STAPL file(s).
• The FlashPro5/4/3/3X default TCK mode setting is Free running clock.

6.2.2 TCK Setting for Force TCK Frequency
If Force TCK Frequency is checked in the Programmer Setting, the selected TCK value is set for the programmer
and the Frequency statement in the PDB/STAPL file is ignored.

 Libero® SoC v2021.2
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6.2.3 Default TCK Frequency
If the IPD/STAPL file or Chain does not exist, the default TCK frequency is set to 4 MHz.

If more than one Microchip flash device is targeted in the chain, the FlashPro Express software passes through all
the files and searches for the "freq" keyword and the "MAX_FREQ" Note field. The FlashPro Express software uses
the lesser value of all the TCK frequency settings and the "MAX_FREQ" Note field values.

6.3 Ping Programmers
Right-click a programmer and choose Ping.

Note:  To ping new programmers quickly, click the Refresh/Rescan for Programmers button.

6.4 Performing a Self-Test
Before performing a self-test, connect the programmer to the self-test board that came with your programmer. Then
right-click the programmer you want to self-test and choose Self Test.

Note:  Self-test is not supported with FlashPro5/4 programmers. These programmers are tested rigorously at the
factory during production.

6.5 Scanning and Checking a Chain
The scan chain operation scans and analyzes the JTAG chain connected to programmers you selected and checks
that a scanned chain matches the chain configured in FlashPro Express.

To scan a chain, right-click the programmer you want to scan and choose Scan and check chain.

6.6 Enabling and Disabling Programmers
After loading a job project, you can enable, disable, or remove a programmer, as well as ping, self-test, run scan,
and check chain on any of the connected programmers. These actions are available in the right-click menu for each
programmer in the programmer column.

Check the check box next to a programmer in the Programmer column to enable the programmer or uncheck the
check box to disable the programmer.

6.7 Renaming a Programmer
Enter a new programmer name in the Programmer window to rename the programmer. By default, the programmer
name is the same as the programmer ID.

6.8 Removing a Programmer
To remove a programmer, right-click the programmer and choose Remove.

6.9 Selecting and Running an Action
FlashPro Express supports the following programming actions:

• DEVICE_INFO
• ENC_DATA_AUTHENTICATION. This action is visible when every device in the chain contains encrypted

bitstream files. Selecting this action checks each bitstream file for authentication.
• ERASE

 Libero® SoC v2021.2
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• PROGRAM
• READ_IDCODE
• VERIFY

To select a programming action, select an action from the Programming Action drop-down menu in FlashPro
Express, as shown in the following figure.
Figure 6-3. FlashPro Express Programming Actions

To run the selected programming action, click the RUN button below the Programming Action drop-down menu.

 Libero® SoC v2021.2
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7. Chain Programming
This section describes how to perform chain programming.

7.1 Chain Order
Chain Programming allows you to program several devices at one time. The order of devices in the chain imported
from Job Project must match the physical chain to be programmed.

The TDO for the first device connects to the programmer, and the last device's TDI connects to the programmer. The
devices in the chain go in order from a device's TDI into the next device's TDO, as shown in the following figure.

Figure 7-1. Chain Order

7.2 Multiple Device Chain Programming
The FlashPro Express software allows direct chain programming without generating a chain STAPL file. Each device
is programmed in sequential order, starting from device 1 to device N (see the following example).

TDI > Device N > Device N-1 >… > Device 2 > Device 1 > TDO

7.2.1 Device Programming Compatibility
PolarFire, SmartFusion2, IGLOO2, and RTG4 devices can be programmed in the same chain.

7.2.2 Programmer Support
FlashPro5/4/3/3X supports PolarFire, SmartFusion2, IGLOO2, and RTG4 devices. The Vpump on FlashPro5/4/3/3X
is designed to support the programming of only one device. Make sure that Vpump, Vcc, and Vjtag are provided
on board for chain programming. Connect the Vpump to the header as the Flashpro Express software will attempt
to check for all external supplies, including Vpump, to ensure successful programming. There is no limitation to the
chain length; however, ensure that the JTAG signal integrity and the timing are preserved.
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8. FlashPro Express Modes
Starting with Libero SoC v12.5, FlashPro Express supports two modes:

• Operator mode
• Developer mode

Operator mode is a current flow that provides production programming. It is the default mode and allows you to run
selected actions for individual and all devices.

Developer mode allows you to:
• Update jobs before running programming.
• Enable or disable chain devices.
• Load design and SPI Flash Programming files and select different programming actions for each chain device

and SPI-Flash.
• Run selected actions for individual and all devices.

You select Operator or Developer mode using the Preference dialog box (Project > Preferences). The preference is
saved per user per machine on Windows and per user on Linux. The mode preference remains the same until you
change it.

Figure 8-1. FlashPro Express Mode Preference Dialog (Windows)
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Figure 8-2. FlashPro Express Mode Preference Dialog (Linux)

The FlashPro Express mode can be switched before opening a job. If a job is opened, you are prompted to confirm
closing of the job to save the mode preference after clicking the OK button.

After a job is opened in Developer mode, each device displays:

• An info ( ) icon with device specific data.

• Design icon ( ). The per-device selected action appears next to the icon if the Run selected action for all
devices option is unselected.

• SPI Flash icon ( ) if SPI Flash programming is available for the device. The per-device selected SPI Flash
action appears next to the icon if the Run selected action for all devices option is unselected.

• Configure button ( ) providing a menu of configuration options based on the device. The configure button is
enabled when no programming action is running.

The following list describes Developer mode features:
• Device configuration options

Figure 8-3. Device Options to Program Design
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Figure 8-4. Device Options to Program Design and SPI Flash

• Enable/Disable device for programming. The option allows the device to be enabled or disabled (put in
“bypass”). You must load the programming file when enabling a device that is in “bypass,” with no programming
file associated with the device or SPI-Flash. The device header info tooltip is updated with selected
programming action if enabled or “bypass” if disabled.
Note:  The job cannot be saved if all devices are disabled or if any enabled devices do not have a loaded
programming file. If all the devices are disabled, an actions combo box and a Run button are disabled.

• Load Programming File. The option is available for the enabled devices to load a different programming file for
the target device. FlashPro Express requires all programming files to be in the local job folder. When loading
a programming file from outside the job folder the file will be copied to the job folder first and then loaded for
the selected device. The user must confirm copying the programming file to the job folder and overwriting the
existing file.

• Select a programming action and configure actions and procedures per device. The option allows the selection
of the programming action and configuration of the actions’ procedures. The option is available for an enabled
device that has programming file loaded, and when the Run selected action for all devices option is
unselected.

• Load SPI Flash file. This option allows you to load a different SPI Flash programming file.
• Select SPI Flash Action. The option allows the selection of the programming action for the SPI Flash. The option

is available for the enabled device that has SPI Flash Programming File loaded, and when the Run selected
action for all devices option is unselected.

• Program device selected actions. In Developer mode, when the Run selected action for all devices check box
is selected, FlashPro Express runs selected action from the drop-down list below the check box for all enabled
devices – similar to Operator mode.
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Figure 8-5. Run One Action for All Chain Devices

When the Run selected action for all devices check box is unselected, the actions drop-down list is disabled.
FlashPro Express runs the programming actions for the enabled device and SPI Flash, as selected uniquely for
each device.
Figure 8-6. Run Device Selected Actions
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9. Tcl Commands
This section describes the FlashPro Express Tcl commands.

9.1 About Tcl Commands
A Tool Command Language (Tcl) file contains scripts for simple or complex tasks. You can run scripts from the
Windows command line, or store and run a series of Tcl commands in a *.tcl batch file.

You can run Tcl commands from scripts or from a Windows or Linux command line. Tcl commands are case sensitive.
However, their arguments are not.

For information about all Tcl commands supported by FlashPro Express, see the Tcl Command Reference Guide
(SmartFusion2, IGLOO2, RTG4) and Tcl Command Reference Guide (PolarFire).

9.2 Executing a Tcl Script File in FlashPro Express
To execute a Tcl script in FlashPro Express:

1. From the File menu, choose Execute Script to display the Run Script dialog box.
Figure 9-1. Run Script Dialog Box

2. Click the Browse button to display the Open dialog box, in which you can go to the folder containing the script
file to open. When you click Open, FlashPro Express enters the full path and script filename into the Run
Script dialog box.

3. In the Arguments box, enter the arguments to pass to your Tcl script. Separate each argument by a space
character.

4. Click Run.

9.3 Running Tcl Scripts from the Command Line
You can run Tcl scripts from a Windows or Linux command line.

1. At the prompt, type the path to the Microchip software followed by the word SCRIPT, a colon, and the name of
the script file, as follows:
<location of Microchip software>/bin/FPExpress.exe SCRIPT:<filename>
The following example executes in batch mode the script foo.tcl:

<location of Microchip software>/bin/FPExpress.exe script:foo.tcl
The following example executes in batch mode the script foo.tcl and exports the log in the file foo.txt:
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<location of Microchip software>/bin/FPExpress.exe script:foo.tcl logfile:foo.txt
The following example executes in batch mode the script foo.tcl, creates a console where the log is displayed
briefly, and exports the log in the file foo.txt:

<location of Microchip software>/bin/FPExpress.exe script:foo.tcl
console_mode:brief logfile:foo.txt
If you leave console_mode unspecified or set it to hide, FlashPro Express executes without a console window.
To leave the console window open, run the script with the console_mode parameter set to show, as in the
following example:

<location of Microchip software>/bin/FPExpress.exe script:foo.tcl
console_mode:show logfile:foo.txt

2. To pass arguments to the Tcl script from the command line, use the SCRIPT_ARGS variable, as follows:
<location of Microchip software>/bin/FPExpress.exe SCRIPT:<filename>
SCRIPT_ARGS:"param1 param2 param3"
Arguments passed to a Tcl script can be accessed through the Tcl variables argc and argv. The following
examples show how a Tcl script accesses these arguments:

puts "Script name: $argv0"
puts "Number of arguments: $argc" set i 0
foreach arg $argv { puts "Arg $i : $arg" incr i
}
Note:  If the script name is protected with double quotes, script names can contain spaces. For example:
FPExpress script:"FPExpress tcl/foo 1.tcl"

9.4 Exporting Tcl Scripts from FlashPro Express
To export Tcl scripts from FlashPro Express:

1. From the File menu, choose Export Script File.
2. Enter the filename and click Save. The Export Script Options dialog appears, as shown in the following figure.

Figure 9-2. Script Export Options Dialog Box

3. Check the Include commands from current project only to export commands of the current project only.
You can specify the filename formatting by selecting Relative filenames (relative to the current directory) or
Qualified filenames (absolute path, including the directory name).

4. Click OK.
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10. Troubleshooting
This section lists the exit codes for PolarFire, RTG4, and SmartFusion2 and IGLOO2.

10.1 PolarFire Exit Codes
The following table lists the PolarFire exit codes.

Table 10-1. PolarFire Exit Codes

Error
Code

Exit Message Exit
Code

Possible Cause Possible Solution

Passed (no error) 0 — —

0x8002 Failed to disable
programming mode

Failed to set
programming mode

5 Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8032 Device is busy 5 Unstable VDDIx voltage
level.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

0x8003 Failed to enter
programming mode

5 Unstable voltage level.

Signal integrity issues on
JTAG pins.

DEVRST_N is tied to
LOW.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

Tie DEVRST_N to HIGH prior to
programming the device.

0x8004 Failed to verify
IDCODE

6 Incorrect programming
file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for reflection.
If TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.
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...........continued
Error
Code

Exit Message Exit
Code

Possible Cause Possible Solution

0x8005

0x8006

0x8007

0x8008

Failed to verify
FPGA Array

Failed to verify
Fabric Configuration

Failed to verify
Security

Failed to verify
sNVM

11 Device is programmed
with a different design or
the component is blank.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Verify the device is programmed with the
correct data/design.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8013 External digest
check via JTAG/SPI
Slave is disabled.

–18 External Digest check
via JTAG/SPI Slave is
disabled.

Need to use a bitstream file which has
a valid FlashLock/UPK1 to enable external
digest check via JTAG/SPI Slave.

0x8015 FPGA Fabric digest
verification: FAIL

Deselect procedure
'DO_ENABLE_FAB
RIC' to remove this
digest check.

–20 FPGA Fabric is either
erased or the data
has been corrupted or
tampered with.

If the Fabric is erased, deselect
procedure DO_ENABLE_FABRIC from
action VERIFY_DIGEST.

0x8016 sNVM digest
verification: FAIL

Deselect procedure
'DO_ENABLE_SNV
M' to remove this
digest check.

–20 sNVM is either erased
or the data has been
corrupted or tampered
with.

If the sNVM is erased, deselect
procedure DO_ENABLE_SNVM from action
VERIFY_DIGEST.

0x8018 User security
policies segment
digest verification:
FAIL

Deselect procedure
'DO_ENABLE_SEC
URITY' to remove
this digest check.

–20 Security segment is either
erased or the data
has been corrupted or
tampered with.

If the security is erased, deselect
procedure DO_ENABLE_SECURITY from
action VERIFY_DIGEST.

0x8019 UPK1 segment
digest verification:
FAIL

Deselect procedure
'DO_ENABLE_SEC
URITY' to remove
this digest check.

–20 UPK1 segment is either
erased or the data
has been corrupted or
tampered with.

If the UPK1 is erased, deselect procedure
DO_ENABLE_SECURITY from action
VERIFY_DIGEST.
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...........continued
Error
Code

Exit Message Exit
Code

Possible Cause Possible Solution

0x801A UPK2 segment
digest verification:
FAIL

Deselect procedure
'DO_ENABLE_UKS
2' to remove this
digest check.

–20 UPK2 segment is either
erased or the data
has been corrupted or
tampered with.

If the UPK2 is erased, deselect
procedure DO_ENABLE_UKS2 from action
VERIFY_DIGEST.

0x801B Factory row and
factory key segment
digest verification:
FAIL

–20 Factory row and factory
key segment have
been erased through
zeroization or the data
has been corrupted or
tampered with.

0x801C Fabric configuration
segment digest
verification: FAIL

Deselect procedure
'DO_ENABLE_FAB
RIC' to remove this
digest check.

–20 Fabric configuration
segment is either erased
or has been corrupted or
tampered with.

If the Fabric configuration is erased,
deselect procedure DO_ENABLE_FABRIC
from action VERIFY_DIGEST.

0x8052 UEK1 segment
digest verification:
FAIL

Deselect procedure
'DO_ENABLE_UEK
1' to remove this
digest check.

–20 UEK1 segment is either
erased or the data
has been corrupted or
tampered with.

If the UEK1 is erased, deselect
procedure DO_ENABLE_UEK1 from action
VERIFY_DIGEST.

0x8053 UEK2 segment
digest verification:
FAIL

Deselect procedure
'DO_ENABLE_UEK
2' to remove this
digest check.

–20 UEK2 segment is either
erased or the data
has been corrupted or
tampered with.

If the UEK2 is erased, deselect
procedure DO_ENABLE_UEK2 from action
VERIFY_DIGEST.

0x8054 DPK segment digest
verification: FAIL

Deselect procedure
'DO_ENABLE_DPK'
to remove this
digest check.

–20 DPK segment is either
erased or the data
has been corrupted or
tampered with.

If the DPK is erased, deselect
procedure DO_ENABLE_DPK from action
VERIFY_DIGEST.

0x8057 SMK segment
digest verification:
FAIL

–20 SMK segment is either
erased or the data
has been corrupted or
tampered with.

If the SMK is erased, deselect
procedure DO_ENABLE_SMK from action
VERIFY_DIGEST.
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...........continued
Error
Code

Exit Message Exit
Code

Possible Cause Possible Solution

0x8058 User Public Key
segment digest
verification: FAIL

–20 User Public Key segment
is either erased or the
data has been corrupted
or tampered with.

If the User Public Key
is erased, deselect procedure
DO_ENABLE_USER_PUBLIC_KEY from
action VERIFY_DIGEST.

0x801D Device security
prevented operation

–21 The device is protected
with user pass key 1 and
the bitstream file does not
contain user pass key 1.

User pass key 1 in the
bitstream file does not
match the device.

Run DEVICE_INFO to view security features
that are protected.

Provide a bitstream file with a user pass
key 1 that matches the user pass key 1
programmed into the device.

0x801F Programming Error. –22 Bitstream file has
been corrupted or was
incorrectly generated.

Regenerate bitstream file.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Bitstream or data is
corrupted or noisy

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8021 Programming Error.

Invalid/Corrupted
encryption key

–23 File contains an encrypted
key that does not match
the device

File contains user
encryption key, but device
has not been programmed
with the user encryption
key.

Provide a programming file with an
encryption key that matches that on the
device.

First program security with master
programming file, then program with user
encryption 1/2 field update programming
files.

0x8023 Programming Error.

Back level not
satisfied

–24 Design version is not
higher than the back-level
programmed device.

Generate a programming file with a design
version higher than the back level version.

0x8001 Failure to read DSN –24 Device is in System
Controller Suspend Mode.

Check board connections.

TRSTB should be driven High or disable
System Controller Suspend Mode.

0x8027 Programming Error.

Insufficient device
capabilities

–26 Device does not support
the capabilities specified
in programming file.

Generate a programming file with the correct
capabilities for the target device.

0x8029 Programming Error.
Incorrect DEVICEID

–27 Incorrect programming
file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file and
select the correct device in chain.

Measure JTAG pins and noise or reflection. If
TRST is left floating, then add pull-up to pin.

Reduce the length of ground connection.
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...........continued
Error
Code

Exit Message Exit
Code

Possible Cause Possible Solution

0x802B Programming Error.

Signal integrity
issues on JTAG
pins, please check.

–28 Signal integrity issues on
JTAG pins, please check.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8030 Programming Error

Invalid or
inaccessible Device
Certificate

–31 FAB_RESET_N is tied to
ground.

FAB_RESET_N should be tied to HIGH.

0x8032

0x8034

0x8036

0x8038

Instruction timed out –32 Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8010 Failed to unlock
user pass key 1

–35 Pass key in file does not
match device.

Provide a programming file with a pass key
that matches pass key programmed into the
device.

0x8011 Failed to unlock
user pass key 2

–35 Pass key in file does not
match device.

Provide a programming file with a pass key
that matches pass key programmed into the
device.

0x804F Bitstream
programming action
is disabled

–38 Unstable voltage level.

Bitstream programming
action has been disabled
in Security Policy
Manager.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of Microchip
specifications. See your device data
sheet for more information on transient
specifications.

Need to use a bitstream file which has
a valid FlashLock/UPK1 to enable the
bitstream programming action.

0x805B Error, security
must be either
programmed on a
blank device or with
the FPGA Fabric
design

–42 Security only bitstream
programming on a
programmed device.

Use this bitstream on a blank device or
generate a new bitstream that contains the
FPGA Fabric design along with the security.

10.2 RTG4 Exit Codes
The following table lists the RTG4 exit codes.
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Table 10-2. RTG4 Exit Codes

Error Code Exit Message Possible Cause Possible Solution

Passed (no error) — —

0x8001 Failure to read DSN Device is in System
Controller Suspend
Mode.

Check board
connections.

TRSTB should be driven High on device
power up.

Disable System Controller Suspend Mode
in the Programming Bitstream Settings tool
within Libero and reprogram the device.

0x8002 Device is busy Unstable VDDIx voltage
level.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

0x8003 Failed to enter
programming mode

Unstable voltage level.

Signal integrity issues on
JTAG pins.

DEVRST_N is tied to
LOW.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

Tie DEVRST_N to HIGH prior to
programming the device.

0x8004 Failed to verify
IDCODE

Incorrect programming
file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for reflection.
If TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.

0x8005 Failed to
verify IDCODE
RT4G150_ES

STAPL file is
not compatible with
RT4G150 production
devices. You must
use a STAPL file for
RT4G150 device.

Programming file is for
RT4G150_ES and device
is RT4G150.

Incorrect programming
file Incorrect device in
chain.

Signal integrity issues on
JTAG pins.

Generate a programming file for RT4G150
device.

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for reflection.
If TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.

0x8006 Failed to verify
IDCODE RT4G150

STAPL file is
not compatible with
RT4G150_ES

devices. You must
use a STAPL file for
RT4G150_ES device.

Programming file is for
RT4G150 and device is
RT4G150_ES.

Incorrect programming
file Incorrect device in
chain.

Signal integrity issues on
JTAG pins.

Generate a programming file for
RT4G150_ES device.

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for reflection.
If TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.
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...........continued
Error Code Exit Message Possible Cause Possible Solution

0x8007 Failed to verify FPGA
Array

Device is programmed
with a different design or
the component is blank.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Verify the device is programmed with the
correct data/design.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8008 Device is blank Attempting to verify
digest of a blank device.

Program the device prior to running the
VERIFY_DIGEST action.

0x8009 FPGA array digest
check is disabled

Digest check has
been disabled by the
Programming Bitstream
Settings tool within
Libero.

Drive TRSTB high during device power up.

Enable digest check in the Programming
Bitstream Settings tool within Libero and
reprogram the device.

0x800A Failed to verify digest:
Instruction timed out

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Run the VERIFY_DIGEST action again.
Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x800B FPGA Fabric digest
verification: FAIL

Programming bitstream
components do not
match components
programmed.

FPGA Fabric is either
erased or the data
has been corrupted or
tampered with.

Use the same programming file that was
used to program the device.

0x800C Factory row segment
digest verification:
FAIL

Programming bitstream
components do not
match components
programmed.

Factory row segment
data has been corrupted
or tampered with.

Use the same programming file that was
used to program the device.
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...........continued
Error Code Exit Message Possible Cause Possible Solution

0x800D Bitstream Error.
Bitstream or data is
corrupted or noisy.

Bitstream file has been
corrupted.

Bitstream was incorrectly
generated.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Regenerate bitstream file.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x800E Failed to query
programming bitstream
settings: Instruction
timed out

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Run the DEVICE_INFO action again.
Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x800F Bitstream Error.
Incorrect DEVICEID

Incorrect programming
file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file and
select the correct device in the chain.

Measure JTAG pins and noise for reflection.
If TRST is left floating then add pull-up to pin.

Reduce the length of Ground connection.

0x8010 Operation has
been disabled by
programming bitstream
settings

Operation has been
disabled by the
Programming Bitstream
Settings tool in Libero.

User disabled Fabric
Erase/Write/Verify and
attempted to Erase/
Program/Verify the
device.

Drive TRSTB high during device power up.

Enable the disabled operation in the
Programming Bitstream Settings tool in
Libero and reprogram the device.

0x8011 Failed to check
bitstream: Instruction
timed out

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

 Libero® SoC v2021.2
Troubleshooting

© 2021 Microchip Technology Inc.
and its subsidiaries

 User Guide DS50003089D-page 37



...........continued
Error Code Exit Message Possible Cause Possible Solution

0x8012, 0x8013 Failed to erase device:
Instruction timed out

Unstable voltage level
Signal integrity issues on
JTAG pins.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8014 Failed to program
device: Instruction
timed out

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that cause
the issue during programming; check for
transients outside of Microchip specifications.
See your device data sheet for more
information on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals for
noise or reflection.

0x8015 Error, device is not
ready.

DEVRST_N may have
been driven LOW during
programming.

Need to ensure that DEVRST_N is driven
HIGH during programming. The reliability of
the device in space cannot be guaranteed
if this has occurred. It is the user's
responsibility to ensure that DEVRST_N is
driven HIGH during programming.

10.3 SmartFusion2 and IGLOO2 Exit Codes
The following table lists the SmartFusion2 and IGLOO2 exit codes.

Table 10-3. SmartFusion2 and IGLOO2 Exit Codes

Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0 Passed (no error) — —

0x8002 5 Failure to configure
device programming at
1.2/1.0 VCC voltage

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8032 5 Device is busy Unstable VDDIx voltage
level.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x8003 5 Failed to enter
programming mode

Unstable voltage level.

Signal integrity issues on
JTAG pins.

DEVRST_N is tied to LOW.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

Tie DEVRST_N to HIGH prior to
programming the device.

0x8004 6 Failed to verify IDCODE Incorrect programming file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file
and select the correct device in the
chain.

Measure JTAG pins and noise for
reflection. If TRST is left floating then
add pull-up to pin.

Reduce the length of Ground
connection.

0x8005

0x8006

8x804A

10 Failed to program
eNVM

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8027

0x8028

10 Authentication Error

Bitstream and device
mismatch

Libero device selection does
not match the target device.

Generate a programming file with the
correct device selection for the target
device.

0x8007

0x804C

11 Failed to verify FPGA
Array

Failed to verify Fabric
Configuration

Failed to verify Security

Device is programmed with
a different design or the
component is blank.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Verify the device is programmed with
the correct data/design.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x8008

0x8009

0x8049

11 Failed to verify eNVM Device is programmed with
a different design.

Unstable voltage level.

Signal integrity issues on
JTAG pins.

Verify the device is programmed with
the correct data/design.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8013 –18 Digest request from
SPI/JTAG is protected
by User Pass Key 1

Digest request from SPI/
JTAG is protected by user
pass key 1.

Lock bit has been
configured in the Debug
Policy within Security Policy
Manager (SPM).

Provide a programming file with a
pass key that matches pass key
programmed into the device.

0x8014 –19 Failed to verify digest >Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8015 –20 FPGA Fabric digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

FPGA Fabric is either
erased or the data has been
corrupted or tampered with.

Use the same programming file that
was used to program the device.

0x8016 –20 eNVM_0 digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

eNVM_0 data has been
corrupted or tampered with.

Use the same programming file that
was used to program the device.

0x8017 –20 eNVM_1 digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

eNVM_1 data has been
corrupted or tampered with.

Use the same programming file that
was used to program the device.
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x8018 –20 User security policies
segment digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

User security policy segment
data has been corrupted or
tampered with.

Use the same programming file that
was used to program the device.

0x8019 –20 User key set 1 segment
digest verification: FAIL

Programming bitstream
components do not match
components programmed.

User key set 1 segment
data has been corrupted or
tampered with.

Use the same programming file that
was used to program the device.

0x801A –20 User key set 2 segment
digest verification: FAIL

Programming bitstream
components do not match
components programmed.

User key set 2 segment
data has been corrupted or
tampered with.

Use the same programming file that
was used to program the device.

0x801B –20 Factory row and factory
key segment digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

Factory row and factory key
segment data has been
corrupted or tampered with.

Use the same programming file that
was used to program the device.

0x801C –20 Fabric configuration
segment digest
verification: FAIL

Programming bitstream
components do not match
components programmed.

Fabric configuration
segment data has been
corrupted or tampered with.

Use the same programming file that
was used to program the device.

0x801D

0x801E

0x804B

–21 Device security
prevented operation

The device is protected
with user pass key 1 and
the bitstream file does not
contain user pass key 1.

User pass key 1 in the
bitstream file does not
match the device.

Run DEVICE_INFO to view security
features that are protected.

Provide a bitstream file with a user
pass key 1 that matches the user pass
key 1 programmed into the device.
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x801F

0x8020

0x8040

–22 Authentication Error

Bitstream or data is
corrupted or noisy

eNVM has been locked by a
master in your design.

Running VERIFY action on
a blank device.

Bitstream file has been
corrupted.

Bitstream was incorrectly
generated.

Release the lock on the eNVM
after your master has completed
its access operations. Write 0x00
to "REQACCESS" register in
eNVM Control Registers (address
0x600801FC) to release the access.

Program the device prior to running
VERIFY action.

Regenerate the bitstream file.

0x8021

0x8022

–23 Authentication Error

Invalid/Corrupted
encryption key

File contains an encrypted
key that does not match the
device.

Attempting to erase a device
with no security using
master security file.

File contains user encryption
key, but device has not been
programmed with the user
encryption key.

Device has user encryption
key 1/2 enforced and you
are attempting to reprogram
security settings.

Provide a programming file with an
encryption key that matches that on the
device.

Run DEVICE_INFO action to verify that
the device has no security. If the device
does not have security, you cannot
erase it.

First program security with master
programming file, then program with
user encryption 1/2 field update
programming files.

You must first ERASE security with
the master security file, then you can
reprogram new security settings.

0x8041 –23 Authentication Error

Invalid/Corrupted
encryption key

File contains an encrypted
key that does not match the
device.

File contains user encryption
key, but device has not been
programmed with the user
encryption key.

Attempting to erase a device
with no security using
master security file.

Device has user encryption
key 1/2 enforced and you
are attempting to reprogram
security settings.

Provide a programming file with an
encryption key that matches that on the
device.

Run DEVICE_INFO action to verify that
the device has no security. If the device
does not have security, you cannot
erase it.

First program security with master
programming file, then program with
user encryption 1/2 field update
programming files.

You must first ERASE security with
the master security file, then you can
reprogram new security settings.

0x8023

0x8024

0x8042

–24 Authentication Error

Back level not satisfied

Design version is not
higher than the back-level
programmed device.

Generate a programming file with a
design version higher than the back
level version.

0x8001 –24 Failure to read DSN Device is in System
Controller Suspend Mode.

Check board connections.

TRSTB should be driven High or
disable "System Controller Suspend
Mode."
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x8025

0x8026

0x8043

–25 Authentication Error

DSN binding mismatch

DSN specified in
programming file does not
match the device being
programmed.

Use the correct programming file with
a DSN that matches the DSN of the
target device being programmed.

0x8044 –26 Authentication Error

Insufficient device
capabilities

Device does not support
the capabilities specified in
programming file.

Generate a programming file with
the correct capabilities for the target
device.

0x8027

0x8028

–26 Authentication Error

Bitstream and device
mismatch

Libero device selection does
not match the target device.

Generate a programming file with the
correct device selection for the target
device.

0x8029

0x802A

0x8045

–27 Authentication Error
Incorrect DEVICEID

Incorrect programming file.

Incorrect device in chain.

Signal integrity issues on
JTAG pins.

Choose the correct programming file
and select the correct device in chain.

Measure JTAG pins and noise or
reflection. If TRST is left floating, then
add pull-up to pin.

Reduce the length of ground
connection.

0x802B

0x802C

–28 Authentication Error

Programming file is
out of date, please
regenerate

Programming file version is
out of date.

Generate programming file with latest
version of Libero SoC.

0x8046 –28 >Authentication Error

Unsupported bitstream
protocol version

Old programming file. Generate programming file with latest
version of Libero SoC.

0x802F –30 JTAG interface is
protected by UPK1

Invalid or no UPK1 is
provided.

User needs to provide correct UPK1 to
unlock device.

0x8030

0x8031

0x8048

–31 Authentication Error

Invalid or inaccessible
Device Certificate

M2S090 Rev. A or M2S150

Rev. A:

Either certificate is corrupted
or the user hasn't provided
the application code in the
eNVM or provided invalid
application code.

FAB_RESET_N is tied to
ground.

User can program a valid application
code. This can be done with
SoftConsole.

FAB_RESET_N should be tied to
HIGH.
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...........continued
Error
Code

Exit
Code

Exit Message Possible Cause Possible Solution

0x8032

0x8033

0x8034

0x8035

0x8036

0x8037

0x8038

0x8039

–32 Instruction timed out Unstable voltage level.

Signal integrity issues on
JTAG pins.

Monitor related power supplies that
cause the issue during programming;
check for transients outside of
Microchip specifications. See your
device data sheet for more information
on transient specifications.

Monitor JTAG supply pins during
programming; measure JTAG signals
for noise or reflection.

0x8010 –35 Failed to unlock User
Pass Key 1

Pass key in file does not
match device.

Plaintext pass key match is
disabled. This occurs if HSM
was used to program the
device.

Provide a programming file with a
pass key that matches pass key
programmed into the device.

Match pass key using HSM.

0x8011 –35 Failed to unlock User
Pass Key 2

Pass key in file does not
match device.

Plaintext pass key match is
disabled. This occurs if HSM
was used to program the
device.

Provide a programming file with a
pass key that matches pass key
programmed into the device.

Match pass key using HSM.

0x8012 –35 Failed to unlock debug
pass key

Pass key in file does not
match device.

Plaintext pass key match is
disabled. This occurs if HSM
was used to program the
device.

Provide a programming file with a
pass key that matches pass key
programmed into the device.

Match pass key using HSM.

0x804D –36 <HSM related error
message based on
scenario>

HSM communication error.
HSM call returns error.

Check whether the communication
path to HSM is up. Make sure project
is loaded properly and that HSM tickets
have not been cleaned.

0x804E –37 Device already has
Security programmed.
Please erase the device
using master file before
reprogramming Security
Settings.

HSM flow does not support
reprogramming device
directly if Security has
already been programmed.

Erase security and try programming
the device.
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11. SmartDebug
Microchip’s SmartDebug tool complements design simulation by allowing verification and troubleshooting at the
hardware level.

For detailed information about SmartDebug for SmartFusion2, IGLOO2, and RTG4, see the SmartDebug User Guide
(SmartFusion2, IGLOO2, RTG4).

For detailed information about SmartDebug for PolarFire, see the SmartDebug User Guide (PolarFire).
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12. Electrical Parameters
This section describes the FlashPro electrical parameters.

12.1 DC Characteristics for FlashPro6
Table 12-1. DC Characteristic for FlashPro6

Parameter Test Condition VJTAG
Voltage Range

Min. Typ
.

Max. Unit

VIH High-
level input
voltage

— 1.20 V to 1.95 V VJTAG_VSPI x 0.65 — — V

— 1.95 V to 2.70 V 1.6 — — V

— 2.70 V to 3.60 V 2 — — V

VIL Low-level
input voltage

— 1.20 V to 1.95 V — — VJTAG_VSPIx0.35 V

— 1.95 V to 2.70 V — — 0.7 V

— 2.70 V to 3.60 V — — 0.8 V

VOH IOH = –100 μA 1.2 V to 3.6 V VJTAG_VSPI - 0.2 — — V

IOH = –3 mA 1.2 V — — — V

IOH = –6 mA 1.4 V 1.05 — — V

IOH = –8 mA 1.65 V 1.2 0.9
5

— V

IOH = –9 mA 2.3 V 1.75 — — V

IOH = –12 mA 3 V 2.3 — — V

VOL IOH = –100 μA 1.2 V to 3.6 V — — — V

IOH = –3 mA 1.2 V — 0.2
5

— V

IOH = –6 mA 1.4 V — — — V

IOH = –8 mA 1.65 V — — — V

IOH = –9 mA 2.3 V — — — V

IOH = –12 mA 3 V — — — V

IOH High-
level output
current

— 1.1 V to 1.2 V — — –3 mA

— 1.4 V to 1.6 V — — –6 mA

— 1.65 V to 1.95 V — — –8 mA

— 2.3 V to 2.7 V — — –9 mA

— 3 V to 3.6 V — — –12 mA
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...........continued
Parameter Test Condition VJTAG

Voltage Range
Min. Typ

.
Max. Unit

— 1.1 V to 1.2 V — — 3 mA

— 1.4 V to 1.6 V — — 6 mA

IOL Low-level
output current

— 1.65 V to 1.95 V — 8 — mA

— 3 V to 3.6 V — 12 — mA

— 2.3 V to 2.7 V — 9 — mA

12.2 DC Characteristics for FlashPro5/4/3/3X
The target board must provide the VCC, VCCI, VPUMP, and VJTAG during programming.

The VJTAG signal is driven from the target/DUT board. The VJTAG pin is sensed by the FP4 to configure the internal
input and output buffers to the same I/O voltage levels. The VJTAG pin is only an input pin to the programmer.

Table 12-2. DC Characteristic for FlashPro5/4/3/3X

Description Symbol Min. Max. Unit

Input low voltage, TDO VIL –0.5 0.35*VJTAG V

Input high voltage, TDO VIH 0.65*VJTAG 3.6 V

Input current, TDO IIL, IIH –20 +20 mA

Input capacitance, TDO 40 pF

Output voltage, VPUMP, operating VPP +3.0 +3.6 V

Output current, VPUMP IPP — 250 mA

VJTAG = 1.5 V

Output low voltage, TCK, TMS, TDI, 100 µA load VOL 0.0 0.2 V

Output low voltage, TCK, TMS, TDI, 4 mA load VOL 0.0 0.30*VJTAG V

Output high voltage, TCK, TMS, TDI, 100 µA load V VJTAG–0.2 VJTAG V

Output high voltage, TCK, TMS, TDI, 4 mA load VOH 0.70*VJTAG VJTAG V

Output current, TCK, TMS, TDI IOL, IOH –4 +4 mA

VJTAG = 1.8 V

Output low voltage, TCK, TMS, TDI, 100 µA load VOL 0.0 0.2 V

Output low voltage, TCK, TMS, TDI, 6 mA load VOL 0.0 0.3 V

Output high voltage, TCK, TMS, TDI, 100 µA load VOH VJTAG–0.2 VJTAG V

Output high voltage, TCK, TMS, TDI, 6 mA load VOH 1.25 VJTAG V

Output current, TCK, TMS, TDI IOL, IOH –6 +6 mA

VJTAG = 2.5 V
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...........continued
Description Symbol Min. Max. Unit

Output low voltage, TCK, TMS, TDI, 100 µA load VOL 0.0 0.2 V

Output low voltage, TCK, TMS, TDI, 8 mA load VOL 0.0 0.6 V

Output high voltage, TCK, TMS, TDI, 100 µA load VOH VJTAG–0.2 VJTAG V

Output high voltage, TCK, TMS, TDI, 8 mA load VOH 1.8 VJTAG V

Output current, TCK, TMS, TDI IOL, IOH –8 +8 mA

VJTAG = 3.3V

Output low voltage, TCK, TMS, TDI, 100 µA load VOL 0.0 0.2 V

Output low voltage, TCK, TMS, TDI, 8 mA load VOL 0.0 0.4 V

Output high voltage, TCK, TMS, TDI, 100 µA load VOH VJTAG–0.2 VJTAG V

Output high voltage, TCK, TMS, TDI, 8 mA load VOH 2.4 VJTAG V

Output current, TCK, TMS, TDI IOL, IOH –8 +8 mA
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13. Electrical Specifications
This chapter describes the FlashPro electrical specifications.

13.1 FlashPro6
FlashPro6 is a JTAG-based programmer for flash based Microchip devices.

The FlashPro6 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on
the FlashPro6 unit is a 2x5, RA male Header connector that is manufactured by 3M and has a manufacturer’s part
number of N2510-5002-RB. This is a standard 2x5, 0.1-pitch keyed connector. Use the 10-pin right- angle header, 3M
P/N N2510-5002-RB (DigiKey P/N MHE10K-ND) for FlashPro6 and use the 10-pin straight header,

The following figure shows the signals on the pins of the FlashPro6 10-pin connector.

Figure 13-1. FlashPro6 10-Pin Connector

Note:  All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The following table lists the signals.

Table 13-1. FlashPro6 Signal Description

Signal Description

GND Signal reference

TCK/SCK JTAG clock; SPI clock

TDI/SDI JTAG data input to device; SPI MOSI

TDO/SDO JTAG data output from device; SPI MISO

TMS/SS# JTAG mode select; SPI Chip Select

nTRST Programmable output pin may be set to off, toggle, low, or high level

VJTAG Reference voltage from the target board

Some designers of high-integrity military and avionic boards may arrange their boards so that TRST is tied to ground
via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by default,
so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not suddenly throw
the JTAG state-machine into an unknown state. If your design also uses a weak pull-down resistor on TRST on
your board, enabling the “Drive TRST” flag will be required to force the JTAG state-machine out of reset to permit
programming to take place. With most boards, there is no need to select this flag.

13.2 FlashPro5
FlashPro5 is a JTAG- and a SPI-based programmer for flash-based Microchip devices.
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The FlashPro5 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on the
FlashPro5 unit is a 2x5, RA male Header connector that is manufactured by AMP and has a manufacturer’s part
number of 103310-1. This is a standard 2x5, 0.1-pitch keyed connector. Use the 10-pin right-angle header, AMP P/N
103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10-pin straight header, AMP P/N 103308-1 (DigiKey
P/N A26267-ND) for the straight version.

The following figure shows the signals on the pins of the FlashPro5 10-pin connector.

Figure 13-2. FlashPro5 10-Pin Connector

Note:  All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The following table lists the signals.

Table 13-2. FlashPro5 Signal Description

Signal Description

VPUMP 3.3 V Programming voltage

GND Signal reference

TCK/SCK JTAG clock; SPI clock

TDI/SDI JTAG data input to device; SPI MOSI

TDO/SDO JTAG data output from device; SPI MISO

TMS/SS# JTAG mode select; SPI Chip Select

nTRST Programmable output pin may be set to off, toggle, low, or high level

VJTAG Reference voltage from the target board

PROG_MODE IGLOO v2 family - used for switching from VCC 1.2 V to 1.5 V during programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not suddenly
throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down resistor on TRST
on your board, enabling the “Drive TRST” flag will be required to force the JTAG state-machine out of reset to permit
programming to take place. With most boards, there is no need to select this flag.

13.3 FlashPro4
The FlashPro4 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on the
FlashPro4 unit is a 2x5, RA male Header connector that is manufactured by AMP and has a manufacturer’s part
number of 103310-1. This is a standard 2x5, 0.1-pitch keyed connector. Use the 10-pin right-angle header, AMP P/N
103310-1 (DigiKey P/N A26285-ND) for FlashPro4 and use the 10-pin straight header, AMP P/N 103308-1 (DigiKey
P/N A26267-ND) for the straight version.

The following figure shows the signals on the pins of the FlashPro4 10-pin connector.
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Figure 13-3. FlashPro4 10-Pin Connector

Note:  All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The following table lists the signals.

Table 13-3. FlashPro4 Signal Description

Signal Description

VPUMP 3.3 V Programming voltage

GND Signal reference

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

nTRST Programmable output pin may be set to off, toggle, low, or high level

VJTAG Reference voltage from the target board

PROG_MODE IGLOO v2 family - used for switching from VCC 1.2 V to 1.5 V during programming

Some designers of high-integrity boards (military and avionic) may arrange their boards so that TRST is tied to
ground via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by
default, so that even with TCK oscillating, some sudden ion bombardment or other electrical event will not suddenly
throw the JTAG state-machine into an unknown state. If your design also uses a weak pull-down resistor on TRST
on your board, enabling the “Drive TRST” flag will be required to force the JTAG state-machine out of reset to permit
programming to take place. With most boards, there is no need to select this flag.

13.4 FlashPro3
The FlashPro3 output is supplied via a connector to which a detachable 10-pin cable is fitted. The connector on the
FlashPro3 unit is a 2x5, RA male Header connector that is manufactured by AMP and has a manufacturer’s part
number of 103310-1. This is a standard 2x5, 0.1-pitch keyed connector. Use the 10-pin right-angle header, AMP P/N
103310-1 (DigiKey P/N A26285-ND) for FlashPro5/4/3/3X and use the 10-pin straight header, AMP P/N 103308-1
(DigiKey P/N A26267-ND) for the straight version.

The following figure shows the signals on the pins of the FlashPro3 10-pin connector.
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Figure 13-4. FlashPro3 10-Pin Connector

Note:  All ground pins must be connected. The rectangular shape shows connections on the programmer itself.
Arrows show current flow towards or from the rectangular programmer.

The following table lists the signals.

Table 13-4. FlashPro3 Signal Description

Signal Description

VPUMP 3.3 V Programming voltage

GND Signal reference

TCK JTAG clock

TDI JTAG data input to device

TDO JTAG data output from device

TMS JTAG mode select

nTRST Programmable output pin may be set to off, toggle, low, or high level

VJTAG Reference voltage from the target board

N/C Programmer does not connect to this pin

Some designers of high-integrity military and avionic boards may arrange their boards so that TRST is tied to ground
via a weak pull-down resistor. The purpose of this is to hold the JTAG state-machine in a reset state by default,
so that even with TCK oscillating, some sudden ion bombardment or other electrical even will not suddenly throw
the JTAG state-machine into an unknown state. If your design also uses a weak pull-down resistor on TRST on
your board, enabling the “Drive TRST” flag will be required to force the JTAG state-machine out of reset to permit
programming to take place. With most boards, there is no need to select this flag.

13.5 JTAG Switching Characteristics
This section describes the FlashPro JTAG switching characteristics.

The following figure shows the JTAG switching characteristics.
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Figure 13-5. JTAG Switching Characteristics

13.5.1 FlashPro6 Characteristics
Table 13-5. JTAG Switching Characteristics for FlashPro6

Description Symbol Min. Max. Unit

Output Delay from TCK to TDI, TMS TTCKTDI 2 2.2 ns

TDO setup time before TCK rising, VJTAG=3.3 V TTDOTCK 11.4 481 ns

TDO setup time before TCK rising, VJTAG=1.5 V TTDOTCK 10.5 487 ns

TDO Hold time after TCK rising TTCKTDO 0 —

TCK period TTCK 49.4 — ns

13.5.2 FlashPro5/4/3/3X Characteristics
Table 13-6. JTAG Switching Characteristics for FlashPro5/4/3/3X

Description Symbol Min. Max. Unit

Output delay from TCK to TDI, TMS TTCKTDI –2 2 ns

TDO setup time before TCK rising, VJTAG=3.3 TTDOTCK 12 — ns

TDO setup time before TCK rising, VJTAG=1.5 TTDOTCK 14.5 — ns

TDO hold time after TCK rising TTCKTDO 0 — ns

TCK period TTCK 41.7 10667 ns
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14. FlashPro Express Reference
Use this chapter as a reference for the FlashPro Express user interface.

14.1 FlashPro Express Start Page
The FlashPro Express Start page is the first page that appears when the tool starts. This page provides the interface
for loading a project into the tool by either navigating to the project location or clicking a recently opened project.

14.2 FlashPro Express Project Menu
The following table lists the FlashPro express project menu details.

Table 14-1. FlashPro Express Project Menu

Command Function

New Job Project New job project folder with programming job name will be created at the
specified location.

Open Job Project Loads a job project into the tool by reading the information in the user-
specified .pro file.

Close Job Project Closes the current job project.

Save Job Project Saves the current job project.

Set Log File Sets the location of the Log file to your specified location.

Export Log File Exports the Log file to your specified location.

Preferences Allows you to select FlashPro Express mode.

Execute Script Runs your specified Tcl script.

Export Script File Exports all commands run in this session to your specified path as a Tcl script.

Exit Exits FlashPro Express.

14.3 FlashPro Express Edit Menu
Table 14-2. FlashPro Express Edit Menu

Command Function

Clear Log Window Clears the Log window.

14.4 FlashPro Express View Menu
Table 14-3. FlashPro Express View Menu

Command Function

Log Window Shows or hides the Log window.
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14.5 FlashPro Express Tools Menu
The following table lists the FlashPro express tools menu details.

Table 14-4. FlashPro Express Tools Menu

Command Function

Programming Connectivity and
Interface

The Programming Connectivity and Interface window displays the physical chain
from TDI to TDO or SPI Slave configuration.

Programmer Settings Opens the Programmer Settings dialog box in which you can set options for
supported Microchip programmers.

Disable Core Check During
Scan and Check Chain

Disables core checking during scan and check chain operations.

14.6 FlashPro Express Help Menu
Table 14-5. FlashPro Express Help Menu

Command Function

Help Topics Opens the help.

Microchip Technical Support Opens the Microchip technical support site.

Microchip Web Site Opens the Microchip website in your default browser.

User Guide Opens the FlashPro Express User Guide.

Check for Software Updates Checks for software updates if you are connected to the Internet.

About FlashPro Express Lists the FlashPro Express release information.

14.7 FlashPro Express Log Window and Status Bar
The following sections describe the FlashPro Express Log window and status bar.

14.7.1 FlashPro Express Log Window
The FlashPro Express Log window shows status messages for user activity.

• Click the appropriate tab (Messages, Errors, Warning, and Info) to filter messages by type.
• Use the right-click menu to copy text, clear the log, and scroll the log.
• Use the def variable LOG_WINDOW_BUFFER_SIZE to set the buffer size.
• Use the View menu to show or hide the Log window.

14.7.2 FlashPro Express Status Bar
The Status Bar at the bottom shows the status of the load project action.
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15. Appendix A: Sample Programming and SmartDebug Times Using
FlashPro5 and FlashPro6
The tables in this appendix show sample programming times using FlashPro5 and FlashPro6 programmers.

The following table shows sample PPD programming times.

Table 15-1. Sample PPD Programming Times

Devices1 PPD Programming Time2 (mm:ss)

FlashPro5 FlashPro6

TCK=4 MHz TCK=4 MHz TCK=20 MHz3

USB 2.0 USB 2.0/3.0 USB 2.0/3.0

M2S/A2GL 005 — — —

M2S/A2GL 010 — — —

M2S/A2GL 025 — — —

M2S/A2GL 050 2min 9sec 2min 10sec 2min 2sec

M2S/A2GL 060 — — —

M2S/A2GL 090 — — —

M2S/A2GL 150 4min 21sec 4min 19sec 3min 54sec

RTG4 2min 10sec 1min 56sec 1min 33sec

MPF100 39sec 28sec 23sec

MPF200 1min 3sec 43sec 28sec

MPF300 1min 33sec 1min 4sec 43sec

MPF500 1min 57sec 1min 34sec 1min

Notes: 
• 1 FlashPro6 supports JTAG programming for all SmartFusion2, IGLOO2, RTG4 and PolarFire devices.
• 2 To benefit from the improved programming time using FlashPro6, use the PPD file format for SmartFusion2,

IGLOO2 and PolarFire devices. Programming time speed up with PPD will be added in future releases.
• 3 To program the device at 20 MHz TCK, take appropriate steps to ensure signal integrity of the JTAG signals.

The following table shows sample SPI Flash programming times, all of which use PPD flow.

Table 15-2. SPI Flash Programming

(N25Q00AA13GSF40G /
MT25QL01GBBB8ESF-0SIT

TR)1

10 MByte data

PPD Programming Time

FlashPro54 FlashPro62

TCK = 4 MHZ TCK = 15 MHz3 TCK = 4
MHZ

TCK = 15
MHz3

TCK = 20
MHz3

USB 2.0 USB 2.0 USB 2.0/3.0 USB 2.0/3.0 USB 2.0/3.0

Program SPI Flash 8min 30sec 5min 29sec 22min 12sec 13min 9sec 12min 11sec
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...........continued
(N25Q00AA13GSF40G /

MT25QL01GBBB8ESF-0SIT
TR)1

10 MByte data

PPD Programming Time

FlashPro54 FlashPro62

TCK = 4 MHZ TCK = 15 MHz3 TCK = 4
MHZ

TCK = 15
MHz3

TCK = 20
MHz3

USB 2.0 USB 2.0 USB 2.0/3.0 USB 2.0/3.0 USB 2.0/3.0

Verify SPI Flash 2hrs 22min 10sec 2hrs 10min 28sec 23min 05sec 14min 17sec 13min 21sec

Read SPI Flash 2hrs 34min 20sec 2hrs 23min 45sec 22min 30sec 13min 54sec 12min 55sec

Erase SPI Flash 19sec 18sec 1min 51sec 1min 49sec 1min 48sec

Notes: 
• 1 SPI Flash programming has been tested on N25Q00AA and MT25QL01G/MT25QU01G devices only. Contact

technical support for other SPI-Flash device support needs.
• 2 FlashPro6 has longer programming times for SPI Flash devices, when compared to FlashPro5. However,

readback and verification times are significantly shorter. Programming time for FlashPro6 will be improved in
future releases.

• 3 To program the device at a high TCK frequency, take appropriate steps to ensure signal integrity of the JTAG
signals.

• 4 FlashPro5 supports MT25QL01G and N25Q00AA13Gxx40G only.
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16. Appendix B: Regulatory and Compliance Information
EU Declaration of Conformity:

This product complies with Directive 2011/65/EU of the European Parliament and of the Council of 8 June 2011 on
the restriction of the use of certain hazardous substances in electrical and electronic equipment.

To view the Declaration of Conformity in English: http://www.microsemi.com/index.php?
option=com_docman&task=doc_download&gid=131772

Non-English: http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=131748

Markings:

 This product complies with 2004/108/EC, Electromagnetic Compatibility (EMC) Directive

For Korea:
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17. Revision History
Revision Date Description

D 08/2021 6.2  Programmer Settings: Updated the Programmer Settings
figure.

C 04/2021 Editorial updates only. No technical content updates.

B 12/2020 Added 5.  Programming Connectivity and Interface section.

Added Construct Automatically option to create new job project
in developer mode, section 4.3  Creating a Job Project from a
FlashPro Express Job.

Updated the following sections for minor edits: 14.5  FlashPro
Express Tools Menu, 6.2  Programmer Settings, 14.2  FlashPro
Express Project Menu.

A 11/2020 Initial Revision.
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18. Microchip FPGA Technical Support
Microchip FPGA Products Group backs its products with various support services, including Customer Service,
Customer Technical Support Center, a website, and worldwide sales offices. This section provides information about
contacting Microchip FPGA Products Group and using these support services.

18.1 Customer Service
Contact Customer Service for non-technical product support, such as product pricing, product upgrades, update
information, order status, and authorization.

• From North America, call 800.262.1060
• From the rest of the world, call 650.318.4460
• Fax, from anywhere in the world, 650.318.8044

18.2 Customer Technical Support
Microchip FPGA Products Group staffs its Customer Technical Support Center with highly skilled engineers who
can help answer your hardware, software, and design questions about Microchip FPGA Products. The Customer
Technical Support Center spends a great deal of time creating application notes, answers to common design cycle
questions, documentation of known issues, and various FAQs. So, before you contact us, please visit our online
resources. It is very likely we have already answered your questions.

You can communicate your technical questions through our Web portal and receive answers back by email, fax, or
phone. Also, if you have design problems, you can upload your design files to receive assistance. We constantly
monitor the cases created from the web portal throughout the day. When sending your request to us, please be sure
to include your full name, company name, and your contact information for efficient processing of your request.

Technical support can be reached at soc.microsemi.com/Portal/Default.aspx.

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms Regulations (ITAR),
log in at soc.microsemi.com/Portal/Default.aspx, go to the My Cases tab, and select Yes in the ITAR drop-down list
when creating a new case. For a complete list of ITAR-regulated Microchip FPGAs, visit the ITAR web page.

You can track technical cases online by going to My Cases.

18.3 Website
You can browse a variety of technical and non-technical information on the Microchip FPGA Products Group home
page, at www.microsemi.com/soc.

18.4 Outside the U.S.
Customers needing assistance outside the US time zones can either contact technical support at (https://
soc.microsemi.com/Portal/Default.aspx) or contact a local sales office.

Visit About Us for sales office listings and corporate contacts.
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The Microchip Website

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner and under normal

conditions.
• There are dishonest and possibly illegal methods being used in attempts to breach the code protection features

of the Microchip devices. We believe that these methods require using the Microchip products in a manner
outside the operating specifications contained in Microchip’s Data Sheets. Attempts to breach these code
protection features, most likely, cannot be accomplished without violating Microchip’s intellectual property rights.

• Microchip is willing to work with any customer who is concerned about the integrity of its code.
• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code

protection does not mean that we are guaranteeing the product is “unbreakable.” Code protection is constantly
evolving. We at Microchip are committed to continuously improving the code protection features of our products.
Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act.
If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue
for relief under that Act.
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Legal Notice

Information contained in this publication is provided for the sole purpose of designing with and using Microchip
products. Information regarding device applications and the like is provided only for your convenience and may be
superseded by updates. It is your responsibility to ensure that your application meets with your specifications.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS IS”. MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR
CONSEQUENTIAL LOSS, DAMAGE, COST OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or
expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox,
KeeLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo,
MOST, MOST logo, MPLAB, OptoLyzer, PackeTime, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip
Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, FlashTec, Hyper Speed
Control, HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC,
ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra,
TimeProvider, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, IdealBridge,
In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, Inter-Chip Connectivity, JitterBlocker, maxCrypto,
maxView, memBrain, Mindi, MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach,
Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE,
Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SMART-I.S., storClad,
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Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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